The articles contained in this magazine are released under the Creative Commons Attribution-Share Alike 3.0 Unported license. This means you can adapt, copy, distribute and transmit the articles but only under the following conditions: you must attribute the work to the original author in some way (at least a name, email or URL) and to this magazine by name ('Full Circle Magazine') and the URL www.fullcirclemagazine.org (but not attribute the article(s) in any way that suggests that they endorse you or your use of the work). If you alter, transform, or build upon this work, you must distribute the resulting work under the same, similar or a compatible license.

Full Circle Magazine is entirely independent of Canonical, the sponsor of Ubuntu projects and the views and opinions in the magazine should in no way be assumed to have Canonical endorsement.
S omething of an unusual **Special Edition** this time, it really is special in that little of this material has appeared in Full Circle Magazine before.

Our on-going Specials are compilations of popular article series published in prior editions of Full Circle. For this one, we’re out on a limb, running new articles, albeit on some familiar topics we’ve touched on, for example in the Q and A section of the magazine.

This is also the first not overseen by our esteemed Editor, Mr Tucker. You are now at the mercy of the demented genius usually in charge (if you can call it that) of the Full Circle Podcast.

While that show is enjoying its Winter break, try not to be too alarmed by the random mind of the man who brought you Mallard Man and Northern Star Trek.

Normal service will be resumed shortly. Enjoy.

Robin Catling

---

**What's the Plan?**

This edition is intended as an all-round introduction to the Ubuntu 11.10 and Unity combo. I've written and posted much in the past on working with the alternatives to Unity; in this edition, we'll take a look at what makes it unique, along with some of the tools and tips you can use to ease into Unity without going for the whole body-shop-and-chop radical re-build. Be aware that some of the settings and tools we’re playing here with can break your Unity desktop.

**11.10 to Unity**

Unity first appeared in 2010 in the original Ubuntu 10.10 Netbook Edition, a re-spin which attempted, much like Sugar OS and others, to provide a simplified, friendlier interface on the smaller, vertically challenged displays of the first generation netbooks. For many people, these were the first computers they had ever owned.

Ubuntu 11.04 was the official release of the Unity desktop across netbooks, desktops, and laptops, alike.

Ubuntu 11.10 marks the full commitment to Unity in place of alternative layouts; GNOME-2 is history, the radical GNOME-Shell is an acquired taste and alternatives such as KDE, Xfce and others are only slowly gaining ground.

Even though there is GNOME

---

“Unity is a shell for GNOME, even if it isn’t GNOME-Shell. We’re committed to the principles and values of GNOME.”

-Mark Shuttleworth, Ubuntu Founder

From this... (Ubuntu Netbook Re-mix)

...to this (Ubuntu 11.10)

---
Release the Ocelot!

The latest version of Ubuntu, 11.10, eccentrically codenamed 'Oneiric Ocelot', was released on October 13, 2011.

What's new?

You can see the list of new features on the right. There’s more detail on the official Ubuntu website, or you can take the snazzy visual tour. You can download the latest builds in desktop or server edition, 32-bit or 64-bit, directly from the Ubuntu Download page.

You can follow the same upgrade process as normal. Simply upgrade from the Update Manager; your settings, files and bookmarks will stay the same. It works. Mostly.

I will qualify that statement as the in-place upgrade worked flawlessly on three of the four laptops, a mixed bag of old and new. Back up your data and settings before you begin.

The Unity launcher and dash are distinctive features in this release; defaulting to Unity 3-D with a fallback to Unity 2-D. There is no GNOME desktop installed in this version. You can of course, opt to go Kubuntu (KDE) or Xubuntu (XFce) as your desktop of choice.

Will it work with my hardware?

Among the FAQs, this is answered with: “Ubuntu 11.10 is built to take advantage of the very latest technologies, but it should work on most desktops, laptops and netbooks too.” Although this fails to point out the need for a 3-D hardware accelerated video card for Unity 3-D.

Feature List

For the desktop edition:

- Linux Kernel 2.6.40 (since updated to 3.0.0)
- GNOME-3, but with Unity in place of Gnome Shell
- GTK 3 (GTK+, or the GIMP Toolkit, is a multi-platform toolkit for creating graphical user interfaces)
- LightDM as default login manager
- X.org 1.10 (the X Window System, often referred to merely as X, is a complete, cross-platform and free client-server system for managing graphical user interfaces (GUIs) on computers)
- Unity improvements and bug fixing over 11.04
- Unity usability, accessibility, automated and stress testing – so it is now much more robust
- Mozilla Thunderbird as the default mail client
- Déjà Dup application for backup tasks
- Utilities for building localized CDs
- Backports package selection was integrated into the UI
- Improvements to Software Center’s Reviews and Ratings functions
- Improved Multi-arch (allows 32-bit applications to run in 64-bit)
- Python updated to version 2.7 and 3.2
- New artwork.
You may be a little disappointed with this one, since it is really about how little you can configure; indeed, how little Canonical, the company behind Ubuntu, wants you to configure Unity.

You’ll find various opinions on this subject, the most telling at Ask Ubuntu, a generally excellent knowledge-base, where a spokesperson for the Unity development team is uncharacteristically blunt:

“I understand that people want the freedom to tweak their

desks, but as soon as you use Compiz Config Settings Manager (CCSM), you have basically opted out of Unity’s future. The bugs you report will not matter since you’re not running the defaults, and any input you may have will be skewed by the customized user experience you’ve devised.”

So there! Yah-boo sucks! If you want to change it, you’re not part of the future. There is an attempt to be a little more conciliatory however:

“Making a new desktop is challenging, and we can’t do it without you. That means filing bugs, proposing new use cases with mock ups, and of course: running the defaults throughout your day.” – ppetraki, 11/22/2011

None of which actually answers the question.

Well, you could try elsewhere on Ask Ubuntu, where there are indexes for both 11.10 and 11.04 versions.

For the hardware-challenged user needing to configure Unity 2D, you have a separate index.

Most of the answers listed there involve the use of Compiz Config Settings Manager, dconf-editor or some elements of Ubuntu Tweak.

Be aware that many of these can break your system and render it unusable. What they still don’t do is open up many features of Unity’s behavior since, well, Canonical just doesn’t trust you to mess with them.

It’s Open Source, Jim, but not as we know it!

Scopes and Lenses

Since the 11.04 release, Unity has moved from the idea of “Places” to a richer set of “Scopes and Lenses.” Scopes are data sources, able to tap into any on-line or off-line data, encompassing a set of filters and some standard interfaces that can generate categorized results for a search. Lenses are various ways to present the data that come from Scopes.

Ubuntu intends for Scopes to have a range of filtering options, such as ratings, “show me all the 5 star apps in the Software Center please,” and categories “…that are games or media related”.

There’s more about lenses over the page.
EXPLORE THE UNITY DASH

It’s a shameless steal from Jorge Castro’s *The Power User’s Guide to Unity*, which has links to all manner of useful Unity stuff over there.

One such is the link to the Ubuntu.com *What’s New* look at the Unity Dash, with a rather splendid 8-point guide to finding your way around the Dash.

“When you click on the Ubuntu logo in the top-left corner of the launcher, the new Dash will appear. It’s another simple way to get to your shortcuts and search for other applications and programs. So you can get fast access to your email, music, pictures and much more. And you can search by type of app or file with our new filters menu.”

**Life Through a Lens**

It’s another item of new terminology that we’re going to see more often in Unity: what is a Lens?

Our faithful guide to all things Unity, Jorge Castro, provides this definition:

“It is a graphical interface for a task, it is also linked in with the dash for search results. For example when clicking the application lens it shows the apps in a nice, slick interface, with other results for like apps to download and most frequent apps.”

There’s a shorter answer:

“Lenses are elements of the Unity Dash that provide a UI to search both the web and application data.”

We’ve shown the illustration of the Music lens on this page.

There’s already a stack of third-party lenses you can install to enhance your Unity experience; check out the post on [Ask Ubuntu for examples](http://askubuntu.com) and installation instructions, but bear in mind these are third party developed and not from Canonical, so install at your own risk and expect the occasional glitch.

---

1. Click on the Ubuntu logo to get to your apps, programs and shortcuts.
2. Look for apps and programs by typing into the search box.
3. Filter results by app or file type.
4. Access your apps, emails, pictures, music and more, fast.
5. The launcher will be disabled when you’re in the Dash.
6. Find apps by category, fast.
7. Superkey shortcut: tap the Superkey to reveal the Dash.
8. Press escape on your keyboard at any time to leave the Dash.
So many people have been asking just what is the right terminology for Ubuntu Unity's UI elements that Jorge Castro and Murat Gunes have jointly put together a post on Ask Ubuntu, which I'm happy to paraphrase, since I didn't know what to call things, either!

Here goes...

- The bar at the top is called a "panel"
- The Ubuntu logo in the top left corner has a name. It's called the "home button", though it's jokingly referred to as the BFB by developers: "Big Freaking Button"
- The left sidebar is NOT called a 'dock.' It's called the Launcher.
- The colored tiles in the Launcher with the icons on them are called "Launcher icons" or "Launcher items"
- The purple tile is called the "workspace switcher"
- The full-screen fly-outs that appear when you click the home button (the Ubuntu logo or "BFB", above), the "Places tile" or the "Apps tile", are ALL called a "Dash"
- "Dash" is the component name for the overlay that's used for Applications and Places. In context you can call the latter the Applications Dash and the Places Dash.

For further information, see the Unity Architecture document, and /Unity/Lenses on the Wiki.

**Other Terms**
The menu is referred to as the Application Menu, not global menu. This is to distinguish it from the other global menu project.

**Pinning Things Down**
There seems to be no agreed single name for items kept on the launcher via the “Keep in launcher” function:

- Developers will find code in the dbusmenu functionality referring to “pinning_item.”
- There's no such thing as a "sticky" anywhere in the Wiki or bug reports.
- “Favorites” is used in the architecture document once; elsewhere you find ambiguous references to “pinned” application items. So “pinned” and “favorites” are in use now.

If you take a look at the screen shot, center, you will see certain elements labeled according to this key:

1. Window Title
2. Application Menu
3. Dash icon
4. Launcher icons
5. Workspace switcher
6. Launcher
7. Trash
8. Indicators
Unity 2-D or Unity 3-D? Fear, uncertainty and doubt prevail, as more users wonder if the Unity desktop is dramatically raising the minimum graphics hardware requirements.

The honest answer from Canonical is no, Unity tries to take advantage of features that have been specified or released many years ago. What they can't tell you is how many of those supported features you have in your ancient box under your desk.

Canonical has tested Unity on a variety of legacy hardware to identify the minimum specs required for Unity, making reasonable assumptions that newer hardware from AMD, Intel and NVidia will be more capable than the ones in the test rig. Tests are aimed at establishing system stability, as well as responsiveness and graphics rendering performance.

There is a standard test that you can run on any bit of kit - even running a Ubuntu Live CD, so you don't have to install first). In a terminal - yes, it's a good ol' command line utility - run:

```
/usr/lib/nux/unity_support_test -p
```

Here's what I get on my trusty Nvidia Go7300 mobile card:

```
robin@d6400:~$ /usr/lib/nux/unity_support_test -p
OpenGL vendor string: NVIDIA Corporation
OpenGL renderer string: GeForce Go 7300/PCI/SSE2
OpenGL version string: 2.1.2 NVIDIA 280.13
Not software rendered: yes
Not blacklisted: no
GL fbconfig: yes
GL texture from pixmap: yes
GL npot or rect textures: yes
GL vertex program: yes
GL fragment program: yes
GL vertex buffer object: yes
GL framebuffer object: yes
GL version is 1.4+: yes
Unity 3D supported: no
```

Looks like it's Unity 2-D for me!

The differences between Unity 2-D and Unity 3-D are almost entirely aesthetic. Unity 2-D disables 3-D effects, shadows, window-snapping and some of the fancy animations effects of Unity 3-D.

The core functions and components of the desktop environment remain the same.

FC Notifier Update

The Full Circle Notifier is still at 1.0.2, but the PPA has been updated for Oneiric. FCN is a small application that sits in your system tray and will announce issue/podcast releases, and can be set to download them too! For more info, see the FCN Google Group: [http://goo.gl/4Ob4](http://goo.gl/4Ob4)
**Update the Ocelot**

**HOW-TO**

**Update Manager**

However recent a build you install, be sure to update Ubuntu at the earliest opportunity. It is a credit to the Open Source community that patches and security updates are applied on a continual and ad-hoc basis. While no computer software is ever guaranteed complete security, you can enjoy the benefits of a well-supported distribution.

You have only to launch the **Update Manager** and click on 'Check Now' to invoke the update process manually.

Also, don't forget the 'PowerMenu' (the top-right cog-wheel icon contains an entry for 'Software up to Date' or 'Updates Available'.

**One Conf Sync**

OneConf is a new feature of the Software Centre. It keeps a list of all your installed applications in sync across multiple computers, so you can have the same working environment wherever you use Ubuntu. To activate it, open the Ubuntu Software Centre and, from the File menu, choose Sync between computers. You will need to create a Software Center Account, but this is no more onerous than UbuntuOne and has the benefit of profiling and storing your software set-up via Canonical's cloud storage.

You’ll no longer have to remember which programs to install when you get access to another Ubuntu instance; but you will need Root privileges for it to synchronise.

(Re-) Enable Third-Party Sources

You may find after upgrading that the 11.10 installer has disabled some of your third-party repositories listed in Software Centre.

Where you have added developers PPA's (Personal Package Archives) and other third-party sources, you should check in Software Center that they still have check marks enabling them, otherwise you'll get no more automatic updates from them.

There may be a good reason why Ubuntu has disabled them; check the distribution version and update any older package sources to match Oneiric or 11.10.

You should check the exact archive name and update the sources line for the new version.

You should also then run a `sudo apt-get update` in a terminal to make sure the package list for those sources is refreshed.

**Additional Drivers in Ubuntu 11.10**

So my wireless card failed to work after the clean install of Ubuntu 11.10 on the net-book. Consulting the forums, I struggled to get the firmware installed; that is, I failed.

Then I stepped back and considered: run the Additional Drivers search first (go to System Settings > Hardware > Additional Drivers)!

This pulled up the appropriate Broadcom drivers without my having to manually tease out the firmware. It was all working again inside 2 minutes.

Note to self - go for the simple, out-of-the-box solutions first, before you go for hard labor.

How or why the installer missed the wireless adapter, I don't claim to understand – importantly it worked from a boot-up using the 11.10 Live CD, ergo, the hardware has to be compatible!
A mong the first things you'll want to do is restore some lost functionality now that Appearance Properties has been dropped in Ubuntu 11.10 and the System Settings doesn't support changing the icon theme!

The Gnome Tweak-UI Tool has dependencies on some Gnome Shell-related libraries which makes installing and running under Unity messy.

Instead, I'm trying dconf-editor (a part of dconf-tools) as a tool to adjust Ubuntu configuration settings. I'm still asking why I need resort to an extra utility to perform a simple task such as changing an icon theme!!

Changing the icon theme in Dconf-editor (a graphical editor and part of the dconf-tools meta-meta-package) is simple enough:

- Launch dconf-editor from a command line, search in the Dash or using the alt-f2 run line using dconf-editor

### Set icon themes in dconf-editor

- Select Org, Gnome, Desktop, Interface
- Enter the name of your desired icon theme into the value field “icon-theme”. Type carefully and remember this is case-sensitive
- If you don't know the exact name of your icon theme, navigate to /usr/share/icons where you can copy the Folder names of the icon sets you have installed.

### Installing dconf-editor

Search on dconf-editor in the Software Center or manually pull it in via the command line using:

```
sudo apt-get install dconf-tools
```

This is one of those power tools that will bring the house down if you're careless. Containing a wealth of settings, it's not always a mine of information, but then dconf-editor wasn't designed as an end-user tool. In the right pane, below each group of values, you will get some description of how it applies; even then, you have to know the possible range of values, such as the exact name of the icon set with spelling, case and punctuation. Use with caution.

### White List Applications

M any of your old familiar programs no longer show up in the new “indicator” area; unless you fool it. Some systray icons for QT-based programs such as Skype and VLC are automatically converted into indicators by sni-qt. Wine, Java, scp-dbus-service and the Update-notifier are white-listed by Ubuntu, but you can white-list all applications.

In dconf-editor, navigate to desktop > unity > panel

And to get the equivalent of the Systray in the Notification Area for all applications, change the default list to ['all']. Or you can add program names individually, in single-quotes, comma-separated, for example 'Wine', 'Skype' etc.

To reset, use the default reset list; the value is shown in the editor itself ['JavaEmbeddedFrame', 'Wine', 'scp-dbus-service', 'Update-notifier'] or click on “Set to default”.

---

**HOW-TO**

**Tweak the Unity Desktop**

---

*full circle magazine: ubuntu 11.10 and unity*
Create a Desktop Shortcut

Thanks to the changes effected by the adoption of GNOME-3 and the Unity interface, adding a desktop shortcut to Ubuntu 11.10 is no longer easy. The old right-click on the desktop, selecting “Create Launcher” no longer works.

However, having some extra icons for your most frequently used programs right there on your desktop may eliminate some of that darting around the Unity Dash. Here’s how.

You can create a custom launcher on the desktop, by invoking the Create Launcher dialog using the terminal command:

```
gnome­desktop­item­edit
­­create­new ~Desktop
```

This one doesn't always work if invoked from the 'run' line opened by the Alt-f2 key combination.

The New Launcher window opens for you to create the launcher command.

The new shortcut will now appear on your desktop as soon as you save it. You need to specify the executable name, which has to be in an executable path, in order for GNOME-Shell underneath Unity to run it.

Bring Back GNOME-Search

My most useful utility is the faithful GNOME-Search tool. With this you can search for any files in any or all locations. It's more powerful than the basic search in the Unity Dash, able to add multiple lines of search criteria.

You can pin this in Unity's Launcher, but I've also created a desktop short-cut as per our article on page 10.

Disable 'For Download' in the Unity Dash

Another 'Marmite' design choice (you'll love it or hate it, indifference is not an option) in the Ubuntu Unity Dash; head for Applications and an entire chunk of the Dash is taken up with “Applications for Download” with a selection taken from the Ubuntu Software Center.

It would be a great idea if it ever suggested anything useful (to me, anyway), but instead it just eats up space in the Dash I could use for other things. Like seeing the stack of favorite programs I already installed, thank you.

In Ubuntu 11.10, this “Applications for Download” section in the Dash can be disabled.

In the `dconf-editor` (see previous page), navigate to desktop > Unity > Lenses > Applications and uncheck the ‘display-available-apps’ box, which is enabled by default.

You will get a whole line of extra space in the Dash from the next time you login.
Add Places as Quick-lists in Unity

Quick-lists in various desktop environments are equally regarded as a compromise of standards as they are usability or ergonomic aids.

Quick-lists are not included as a standard feature in Ubuntu 11.10. However, you can add your profile’s Places as Quick-lists.

First, copy the current ‘Home Folder’ launcher file to your home directory. The quickest and easiest way is through the command line - in a terminal, (Unity Shortcut Ctrl+Alt+T) you can copy-paste the following:

```
cp /usr/share/applications/nautilus-home.desktop ~/.local/share/applications/nautilus-home.desktop
```

Edit this using a text editor, for example, Gedit:

```
[Desktop Entry]
Name=Home Folder
Comment=Open your personal folder
TryExec=nautilus
Exec=nautilus --no-desktop
Icon=home
Terminal=false
StartupNotify=true
Type=Application
Categories=GNOME;GTK;Core;
OnlyShowIn=GNOME;Unity;
X-GNOME-Bugzilla-Bugzilla=GNOME
X-GNOME-Bugzilla-Product=nautilus
X-GNOME-Bugzilla-Component=general
X-Ubuntu-Gettext-Domain=nautilus
X-Ayatana-Desktop-Shortcuts=Videos;Documents;Music;Pictures;Downloads

[Pictures Shortcut Group]
Name=Pictures
TargetEnvironment=Unity
Exec=nautilus Pictures

[Documents Shortcut Group]
Name=Documents
TargetEnvironment=Unity
Exec=nautilus Documents

[Music Shortcut Group]
Name=Music
TargetEnvironment=Unity
Exec=nautilus Music
```

Save the file.

Restart Unity. Opening a terminal to run `unity --replace` is unsafe in my 11.10 instances as Unity hangs so badly, so I log out and log back in to restart Unity.

Disable Overlay Scrollbars

Ever since they arrived in the test versions of 11.04, I’ve hated the new Overlay Scrollbars in Ubuntu.

Yes, it may save on-screen real estate BUT:

- I now got a much smaller target to hit just to get the overlay control to appear
- I have to move the mouse again most times to get the pointer onto the sweet spot to drag

In theory, overlay scrollbars are a brilliant space saver. In practice, they are an insane idea that drives me crazy AND drives a coach and horses through common-sense accessibility!

Here’s how to disable the overlay scrollbars in Ubuntu 11.10 if you can handle the following commands:

```
sudo su
echo "export LIBOVERLAY_SCROLLBAR=0" >> /etc/X11/Xsession.d/80overlayscrollbars
```

Then restart your x-server (reboot if you don’t trust the command line again).

If this solution doesn’t work, you can alternatively remove the overlay scrollbars packages which will eradicate all trace of them (so any other users of your machine will lose them permanently too):

```
sudo apt-get remove overlay-scrollbar liboverlay-scrollbar-0.1-0
```
Stop Zeitgeist
Displaying Everything in the Dash

Zeitgeist is the event logging tool built into Ubuntu; it provides the engine for much of the user search capabilities and results for things like the Dash. You may think it's a marvel or the biggest source of embarrassment, depending on who's looking over your shoulder.

Activity Log Manager for Zeitgeist is available through the Software Center and provides a little more control.

You can use the 'Files' tab to blacklist the folders where you keep private files.

You can also completely disable Zeitgeist by unchecking the 'Logging active' button at the bottom; this will black out all file searches in the Dash, so the first method, blacklisting only certain folders or applications, may be of more benefit. This application will also clear the Zeitgeist history and, by extension, the Dash history along with it.

Bypass Software Center to Force Package Installs

Sometimes, Ubuntu Software Center won't let you install some program or other, displaying the error: “The package is of bad quality.”

While this may be true and sound advice, this doesn't help when the package in question belongs to one of your indispensable programs.

You can bypass Software Center and force the install of a .deb package in two ways.

The first is using DPKG, another command line option taking the format:

```
sudo dpkg -i PACKAGENAME.deb
```

The second option is to resort to the Gdebi package installer, which is a stand-alone graphical front-end to install packages without all of Software Center’s checks.

You could also get the Ejecter AppIndicator which sits in your Notification area.

Remove Mounted External Drives and Partitions from the Launcher

If you find your Launcher bar cluttered with every external device and mounted partition, you can stop Unity displaying them there with one more terminal command:

```
gsettings set com.canonical.Unity.Devices devices-option "Never"
```

You could also get the Ejecter AppIndicator which sits in your Notification area.

Get More AppIndicators

There is a huge list of further Appindicators available over on Ask Ubuntu, which just goes to show how utility will override design intentions any day!
You're still not getting on with Unity desktop in everyday use, Xfce has a few quirks and Kubuntu is still a culture shift too far.

You could drop back to the look and feel of GNOME-2! Panels and menus are fast and lightweight and do just what's needed. They are also easy to achieve thanks to a couple of small package installs, which give me the desktop shown.

Firstly, install the package ‘gnome-fallback-session’ from the Ubuntu Software Center. This one package does the hard work.

Log out of your desktop back to the LightDM login manager and choose ‘GNOME Classic (No Effects)’ session from the session drop-list. Hit the cogwheel next to your user name to choose it before you log in.

This opens a classic 2-panel desktop, in a GNOME-2 'stylee'. You can change the Panel backgrounds (or not) to suit yourself.

The critical change in operation is the ALT and right-click combination for making changes to panels. It's an accessibility-busting key plus mouse combination, but that's what fallback has to work with:
- Alt+right-click on the top panel
- choose ‘Properties’
- select the ‘background’ tab
- select background image and click the button

Browse your ‘usr/share/themes/’ folder and see what you've got that contains ‘panel’ and .png; for example: Ambience/gtk-2.0/apps/img/panel.png

Update the Software Center, then install 'Indicator-applet-complete'.

Via the terminal you can alternatively install using:

```
sudo add-apt-repository ppa:jconti/gnome3
sudo apt-get update
sudo apt-get install indicator-applet-complete indicator-applet-session
```

(Note this pulls in dependent packages)

To complete the set-up:
- Alt+right-click on the top panel
- Choose ‘Add Applets’
- Add ‘Indicator Applet Complete’

**Customize**

To add, remove and move panel items is very easy, GNOME-2 style: ALT+right-click on a panel or item to add, move or edit it.
**HOW-TO: TWEAK THE UNITY DESKTOP**

### Change the LightDM Greeter Background

LightDM login manager is much more useful and visually pleasing than the old GDM login, albeit with a fixed background wallpaper at present. Fairly soon, you will have the option for the LightDM login manager to automatically pick up the default wallpaper for any username highlighted at the login selection screen.

In the meantime, you can set the wallpaper to pretty much anything you want using another magic setting in one of the LightDM configuration files. This applies in Ubuntu 11.10 and 12.04.

You will have to launch a text editor with root privileges from the terminal (or via the run box using Alt+F2):

```
gksu gedit /etc/lightdm/unity-greeter.conf
```

Look down the settings until you find the line beginning `background=`

Change the background filename to anything you want to use, but do make sure you get the correct, absolute path to the file name (with extension), for example:

```
/home/robin/Pictures/saas_fee_bg.jpg
```

Needless to say, your choice of wallpaper needs to be accessible on a local file-system that is already mounted when LightDM loads.

Save the file, log out to the LightDM greeter and see your glorious wallpaper!

Sadly the overlaid grid of dots isn’t removable until 12.04.

### Classic Gnome Panel Fix for Compiz Compositing

By default, the GNOME Classic Session grates with Compiz compositing in Ubuntu 11.10, for a less-than-perfect performance. The fix is to edit the gnome-classic.session configuration file. The fastest way is via the terminal:

```
gksu gedit /usr/share/gnome-session/sessions/gnome-classic.session
```

Amend the line:

```
RequiredProviders=windowmanager;notifications;
```

by removing `notifications;` from the end of the line:

```
RequiredProviders=windowmanager;
```

Save the file, log out and you can log back into Gnome Fallback using the ‘GNOME Classic’ option instead of ‘GNOME Classic (No effects)’.

### Reset Unity To Default Settings

After tweaking Unity using tools such as Compiz or Ubuntu Tweak, you can find yourself with problems or find that something no longer works. *Caveat emptor…*

Unity settings can be 'reset', though. It’s another terminal command:

```
unity --reset
```

That’s a space and two dashes in the reset option.
Add Users to Groups in Ubuntu 11.10

Amongst the mixed bag of 'features' in Ubuntu 11.10 is the lack of a proper user and group admin tool. We had one in 11.04, you could do anything with user and group permissions from a graphical interface. Easy.

Come 11.10, that goes away and all you can do is add or remove user accounts or change the account type (Standard or Administrator). Try setting up VirtualBox and Samba shares and see how far you get. If you want to add new or existing users to existing groups, it is impossible to do from the user account management dialog box.

Canonical, you just made a large number of us resort to a command line. Again. How 'very Linux'. Anyway, back in the geek ghetto, let's move on...

Open a Terminal (Ctrl-Alt-T keyboard shortcut). The command to list all existing groups on your system is:

```
$ groupmod
```

but press the TAB KEY 3 TIMES, not Enter;

The command to add an existing user to an existing group follows the format:

```
sudo usermod -a -G GROUPNAME USERNAME
```

Replace `<Groupname>` with the required group name and `<Username>` with an account name. For example:

```
sudo usermod -a -G samabashare robin
```

It's one of those command lines that doesn't give feedback.

To verify success, run the command:

```
cat /etc/group
```

The username should appear in all groups of which the user is a member.

Ubuntu 12.04 really should find a way to restore the missing utility.

Oh! It turns out there is... Curiously, if you search the Software Center, or run the command:

```
sudo apt-get install gnome-system-tools
```

You can still find the `gnome-system-tools` package containing the old User Account Admin tool!
Fix 'Untrusted Packages'
Error in Ubuntu 11.10

If you've added PPAs (Personal Package Archives) to your software sources in Ubuntu, you may find you get an error when you try to run updates in the Update Manager:

'Requires installation of untrusted packages'

This is typically owing to missing GPG keys for those PPAs so that Update Manager can't verify those updates. It will simply refuse to install those updates. It is easy to fix.

Open a Terminal session and run the command

```
sudo apt-get update
```

The PPAs that are being refused will show up having no public key

Take note (perhaps copy and paste from the terminal using shift-control-C to copy) those 16-digit hexadecimal key numbers appearing after 'NO_PUBKEY'.

To fix this, get the public key value, import it into your list of software sources, then re-verify those sources.

To install the missing public keys, run the command for each missing key, replacing my example with your key value:

```
sudo apt-key adv --recv-key --keyserver keyserver.ubuntu.com 52A794126E3AB2D3
```

You should get a result looking something like this:

```
robin@D6400:~$ sudo apt-key adv --recv-key --keyserver keyserver.ubuntu.com 52A794126E3AB2D3
Executing: gpg --ignore-time-conflict --no-options --no-default-keyring --secret-keyring /tmp/tmp.xoyVBC269z --trustdb-name /etc/apt/trustdb.gpg --keyring /etc/apt/trusted.gpg --primary-keyring /etc/apt/trusted.gpg --recv-key --keyserver keyserver.ubuntu.com 52A794126E3AB2D3
gpg: requesting key 6E3AB2D3 from hkp server keyserver.ubuntu.com
```

You can then use the update command below to verify your software sources list, approving those PPAs for updates:

```
sudo apt-get update
```

Update Manager should now run to completion without this error.
**Disable Guest Login**

If you’re sociable and you like having guests in your house, or indeed, logged onto your computer, skip over this. If you have a need to lock out casual visitors to your machine, then you’ll want to ditch the guest login that came by default with Ubuntu 11.10.

I ‘Guest’ became a default on the login list with the LightDM login manager in 11.10 and I just want to take it out of the login list.

This is easy enough if you’re using the default LightDM in Ubuntu 11.10. Edit the LightDM configuration file `/etc/lightdm/lightdm.conf`, with root privilege:

```
sudo gedit /etc/lightdm/lightdm.conf
```

In the section SeatDefaults and add the line `allow-guest=false` in the manner of:

```
[SeatDefaults]
egreeter-session=unity-greeter
user-session=ubuntu
allow-guest=false
```

Save the document.

LightDM needs a restart, or you can use a terminal command

```
sudo restart lightdm
```

which will return to your login screen where the guest account is disabled. Save and close anything else that’s running first!

If you’re still using GDM (which was the default in previous Ubuntu releases), it’s a package removal, you have to uninstall gdm-guest-session.

**Home Folder Encryption**

How paranoid are you about theft or the sensitivity of your personal and business data? You may want to consider encrypting your Home folder.

The Ubuntu 11.10 installer, offers to securely encrypt the Home folder; put the check in the box for this during the install.

On first login, you will be prompted for an encryption passphrase to your private home folder. You may as well allow the `encrypt-fs` software to generate your pass phrase, it will generate a strong pass phrase consisting of at least 32 uppercase and lowercase letters, numbers, white spaces and special characters.

Unlike ordinary passwords you will never enter it directly yourself; it generates a 128-bit (16 character) hash key. Store this in a safe and secure place, it is the key to recovering the data from your Home folder if you ever have to manually recover.

If you don’t choose this option during Ubuntu 11.10 installation, you can easily do it later by installing `ecryptfs-utils`, which is in the Ubuntu Software Center or by running the terminal command

```
sudo apt-get install ecryptfs-utils
```

After installing this package you should be able to select “Encrypt Home Folder” from the right-click menu in Nautilus. The command

```
sudo ecryptfs-migrate-home -u USERNAME
```

will encrypt the home folder for the specified username.
As has been expressed in Full Circle in the past, there is no such thing as an inherently intuitive computer interface. We all draw on the iconography and experience of the technology we use in our daily lives.

If we are lucky enough to live in a developed economy that includes televisions, phones, ticket machines, elevators, even bus stops; not to mention all those other computers badged by fruit-based marketers and some outfit with wobbly architecture (that’s what you get when you have a life without walls, apparently).

What Ubuntu Linux has dared to do is to break away from the hotch-potch of all that technology and do things a little differently, in a new way, reaching out to new users. Unfortunately that has left some in the established base a little at sea, as some of those 'old ways of doing' were accumulated over the last thirty years of effort; even some of the new people think that Unity departs from what some might call 'common standards.' Whatever those are.

So we arrive at Ubuntu 11.10, with its distinctive and controversial interface. Controversial if you're one of the Linux in-crowd for whom all this is deadly serious. New users don’t seem all that bothered. Just give them a CD of Ubuntu and let them get on with it.

What the 11.10 release represents is the turn taken at the crossroads, on an accelerating journey, using a vehicle that, truthfully, is being bolted together along the way.

With it’s tight development deadlines, Ubuntu 11.10 became a scramble to shoehorn in as much new code as possible so as not to jeopardize the stability of the Long Term Support coming in 12.04 with GNOME-3 and Unity front and center.

For all the things that have been added, others have been taken away. Few will miss the nitro-glycerine-in-a-deb-package that was Computer Janitor, able to blow the house down with one mouse click. However, things we are missing include some of the theming options we had under the now departed GNOME-2.

More serious is the lack of the full tools for user account admin, driving veterans and newcomers alike back to a command-line interface.

And for all 11.10’s sophistication, some have felt the need to carry over old tools or develop new ones to make up this shortfall; Compiz Config Settings Manager, MyUnity, Unity Tweak and others, which hasn't always pleased those back at the Canonical Mother-SHIP.

Let’s see if we can’t steer a middle path, stay on the road and get there with a little more comfort.

Shock of the New

Is it more a case of human resistance to change? Let’s face it we all get set in our ways and the challenge is to embrace new things, new concepts and new methods.

Since the sky hasn’t fallen in, why don’t we look forward to the next phase of innovation?

Image: Tom’s Window Manager by Liberal Classic/Wikipedia

Robin Catling is a freelance project manager, performer, writer, sports coach and all-round eccentric. His blog is the Catling Mindswipe. You can follow his Twitterfeed @robincatling. Culture-vultures can also go to Everything Express.
THE FUTURE: UNITY and HUD

“Say hello to the Head Up Display, or HUD, which will ultimately replace menus in Unity applications.”

Thus Mark Shuttleworth, the Chairman of Canonical, announced the next development of the Unity interface at the start of the year. The HUD is intended to apply the Unity Dash search method to any Unity-compliant application.

In a post full of enthusiasm for re-modeling the Graphical User Interface: “...it’s a way for you to express your intent and have the application respond appropriately. We think of it as ‘beyond interface’, it’s the ‘intenterface’... ‘intent-driven interface’.”

Mark makes a good case:

“Menus serve two purposes. They act as a standard way to invoke commands which are too infrequently used to warrant... a toolbar button, and they serve as a map of the app’s functionality..., that one can scan to get a feel for ‘what the app does’. It’s command invocation that we think can be improved upon, and that’s where we are focusing our design exploration.

" As a means of invoking commands, menus have some advantages.

● they are always in the same place (top of the window or screen)
● they are organized in a way that’s quite easy to describe over the phone, or in a text book (“click the Edit-> Preferences menu”), they are pretty fast to read since they are generally arranged in tight vertical columns
● they require you to read a lot when you probably already know what you want

HUD suggesting sites in Firefox

Thus Mark Shuttleworth, the Chairman of Canonical, announced the next development of the Unity interface at the start of the year. The HUD is intended to apply the Unity Dash search method to any Unity-compliant application.

In a post full of enthusiasm for re-modeling the Graphical User Interface: “...it’s a way for you to express your intent and have the application respond appropriately. We think of it as ‘beyond interface’, it’s the ‘intenterface’... ‘intent-driven interface’.”

Mark makes a good case:

“Menus serve two purposes. They act as a standard way to invoke commands which are too infrequently used to warrant... a toolbar button, and they serve as a map of the app’s functionality..., that one can scan to get a feel for ‘what the app does’. It’s command invocation that we think can be improved upon, and that’s where we are focusing our design exploration.

" As a means of invoking commands, menus have some advantages.

● they are always in the same place (top of the window or screen)
● they are organized in a way that’s quite easy to describe over the phone, or in a text book (“click the Edit-> Preferences menu”), they are pretty fast to read since they are generally arranged in tight vertical columns
● they require you to read a lot when you probably already know what you want
● they are more difficult to use from the keyboard than they should be, since they generally require you to remember something special (hot-keys) or use a very limited subset of the keyboard (arrow navigation)
● they force developers to make often arbitrary choices about the menu tree (“should Preferences be in Edit or in Tools or in Options?”) and then;
THE FUTURE: UNITY and HUD

they force users to make equally arbitrary effort to memorize and navigate that tree.

The current prototype is a 'vocabulary UI', or VUI, intended to be closer to the way users think; you think of an action or an object in the application - the menu tree is no longer important. What’s critical in this model is the efficient matching of what the user says and the commands offered up.

It’s supposedly a smart interface, employing fuzzy matching to pick up synonyms and it can learn your usual work patterns so it can prioritize the things you use often;

“When you’ve been using it for a little while it seems like it’s reading your mind, in a good way.”

Glad you added that last, Mark.

You should first of all take a look at the demonstration video to see HUD in action. Some of it, such as controlling the Banshee music player, looks very slick already.

User interface changes can be a poisoned chalice. Unity isn’t universally liked by all Ubuntu users (restrain yourselves!). While Apple tends to push through any user complaints in its own patrician way, Microsoft is still struggling for equilibrium with the Ribbon interface, which still confuses millions with its ever-changing clutter of icons

Canonical is going the other way by removing ALL the chrome, menus, and 'clutter' from your desktop. It will work with any application that can use the Unity global menu, which includes most GTK and Qt Programs.

Not surprisingly, HUD is meeting a mixed response. For example:

“When you've been using it for a little while it seems like it's reading your mind, in a good way.”

“Terrible. Who looks at a GUI and says, ‘You know what this needs? More typing’.”

Certainly, when you're in an application with hands on the keyboard in a typing position already, the HUD will be very convenient, but mousing around, say, chasing links on a website, or tool palettes in GIMP, Inkscape, or Scribus? The clunking Inkscape example in the video 'wiping away nested menus' perversely only illustrates the obstacles HUD has yet to overcome.

Discovery, or 'discoverability' is another area of concern, along with the vocabulary of the user which has to coincide with the lexicon in the HUD before it offers any programs or commands. If the HUD can search on application descriptions and categories too, then it may well work better.

However, HUD is going to have to be some mindreader to help you find commands when you don’t know what you’re looking for. How do you discover menu items that you don’t know they exist? A new user might open a menu, select Edit, look at the selection beyond the standard Find/Replace/... and there’s an item they've never seen before.

Quite how this is going to work for Asian language territories with typing issues has yet to be seen.

HUD is currently a first cut prototype available for the 12.04 Alpha release and, if you’re brave, you can install it in 11.04. It is entirely dependent on Unity 3-D overlays and transparency effects, however, so without these, you won’t even see it, much less be able to try it.

See the HUD demo on YouTube

full circle magazine: ubuntu 11.10 and unity 19
REVIEW

Unity: Simplify Your Life (e-book)

This e-book in PDF format begins with some common computer user issues, before declaring:

"Ubuntu 11.04's Unity interface wants to turn these scenarios into problems of the past. Unity's foremost goal is to get you Simplicity. Elegance. Speed. Responsiveness. It's all here."

Although this is still the Ubuntu Unity 11.04 edition, the user guide provided by the Ubuntu Vancouver LoCo team remains a valuable Unity resource. With general chapters such as 'Unity in 15 Minutes' and 'Unity. How It All Fits Together', you also get detailed breakdowns such as 'Personalizing the Launcher', 'Using the Dash' and introductions to Unity concepts such as 'What is a Lens?'

This is a 98-page e-book and the first fifty pages do an excellent job of explaining the Unity interface with annotated screenshots. It is all thoughtfully presented in plain language, with plenty of whitespace on the pages giving it a clear, uncluttered layout. The Vancouver LoCo (Pritpaul Bains with editors Charlene Tessier and Randall Ross) clearly know about publishing.

However, the next section is more of a general 'using Ubuntu' guide, under the slightly grandiose heading 'Unity. For Your Life.' This goes through all the common tasks a new Ubuntu user will want to perform: surf the Internet, play music, view photo's and so on, all illustrated in the context of Unity.

Now, some of these are very specific to individual applications - using Firefox and LibreOffice - others, such as 'Find Your Files' and searching from the Dash, right back in the specifics of Unity. You could argue that the general material belongs somewhere else and that they should have confined the book to Unity operation only, but I'm prepared to go with the Vancouver team's approach that this is primarily a book for the newcomer; the old hands can pick and choose the sections they want.

There's a nod to the inquisitive, newcomers and veterans alike, in Appendix A which describes some of the underlying components of the Ubuntu Unity release: GNOME desktop, Compiz rendering, Zeitgeist event logger. I have a slight issue in that the 'Customizing Unity' section is back here in Appendix B when surely it ought to be a main chapter?

Appendix C, 'The Future' is the look forward (or 'there's more jelly tomorrow, trust us') for the skeptics like me who pick holes in the current release of Unity.

There's a Unity Keyboard Shortcuts quick reference in Appendix D that we could all find valuable.

While this is a PDF e-book which is fully searchable, it's good to have a proper index in the back anyway. There are plenty of internal links to cross-reference different sections, the annotated screenshots are clear, with just enough illustrations, which are always relevant to the point.

It's no small undertaking to produce something of this quality so congratulations to Vancouver LoCo team.

Unity: Simplify Your Life is available from http://ubuntuone.com/p/1AAB/
HOW TO CONTRIBUTE

We are always looking for new articles to include in Full Circle. For article guidelines, ideas, and for issue translation, please see our wiki:
http://wiki.ubuntu.com/UbuntuMagazine
Please email your articles to: articles@fullcirclemagazine.org

If you would like to submit news, email it to: news@fullcirclemagazine.org
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
...or you can visit our forum via: www.fullcirclemagazine.org

FULL CIRCLE NEEDS YOU!
A magazine isn’t a magazine without articles and Full Circle is no exception. We need your Opinions, Desktops and Stories. We also need Reviews (games, apps & hardware), How-To articles (on any K/X/Ubuntu subject) and any questions, or suggestions, you may have.
Send them to: articles@fullcirclemagazine.org

Full Circle Team
Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Comms Mgr - Robert Clipsham
mrmonday@fullcirclemagazine.org
Podcast - Robin Catling
podcast@fullcirclemagazine.org

Editing & Proofreading
Mike Kennedy
Lucas Westermann
Gord Campbell

Our thanks go out to Canonical, the many translation teams around the world and to Thorsten Wilms for the current Full Circle logo.

Editing & Proofreading this Edition
Victoria Pritchard